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1. PURPOSE: to describe the standardized laboratory protocol for molecular subtyping of Shiga 

toxin-producing Escherichia coli O157 (STEC O157) and Salmonella enterica serotypes 

Typhimurium and Enteritidis. 

 

2. SCOPE: to provide the PulseNet participants with a single protocol for performing MLVA of 

STEC O157 and Salmonella serotypes Typhimurium and Enteritidis, thus ensuring inter-laboratory 

comparability of the generated results. 

 

3. DEFINITIONS: 

3.1 MLVA: Multiple-locus variable-number tandem repeat analysis 

3.2 VNTR: Variable-number tandem repeat 

3.3 DNA: Deoxyribonucleic acid 

3.4 DNase: Deoxyribonuclenase 

3.5 PCR: Polymerase chain reaction 

3.6 HPLC: High purity liquid chromatography 

3.7 dNTP: Deoxyribonucleotide triphosphate 

3.8 CDC: Centers for Disease Control and Prevention 

3.9 SOP: Standard Operating Procedure 

 

4. RESPONSIBILITIES/PROCEDURE 

4.1.   Biosafety warning: STEC O157 and Salmonella serotypes Typhimurium and Enteritidis 

with an infectious dose as low as 100 cells is a human pathogen capable of causing 

serious disease. Always use a minimum of Biosafety level 2 practices and extreme 

caution when transferring and handling strains of these serotypes. Work in a biological 

safety cabinet when handling large amounts of cells. Disinfect or dispose of all plastic 

ware and glassware that come in contact with the cultures in a safe manner. 

4.2.   Reagents, supplies and equipment needed for DNA template preparation 

4.2.1 Trypticase soy agar with 5 % sheep blood (TSA-SB) or comparable media 

4.2.2 1 µl inoculation loops 

4.2.3 0.5 ml microcentrifuge tubes 

4.2.4 DNase-free, molecular biology -grade water 

4.2.5 Vortex 

4.2.6 Boiling water bath or thermocycler/thermal block accommodating 0.5 ml tubes 

4.2.7 Tabletop centrifuge for high rpm (up to 13,000-14,000 rpm) spinning 

4.2.8 Pipets (200 µl) for aliquoting 100 µl of DNase-free, molecular biology-grade water 

          4.2.9 Filtered Sterile Pipet tips 

4.3. Reagents, supplies and equipment needed for PCR 

4.3.1  DNA templates from isolates (keep at -20
o
C or -80ºC freezer for long term) 

4.3.2  PCR primers (see appendix PNL28-1) 

4.3.2.1   Fluorescent-labeled forward primers 

4.3.2.1.1   HPLC-purified 

4.3.2.2   Unlabeled reverse primers 
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4.3.2.2.1   Regular gel filtration purification  

4.3.2.3 Biosearch Technologies (Novato, CA; www.biosearchtech.com; 1-800-436-

6631) sells primers labeled with the three dyes needed for the protocol 

4.3.2.4   Divide the concentrated stocks (100 µM) in portions and store at -80ºC freezer 

4.3.2.4.1 One vial should contain enough to prepare 25-50 µl of working solution. 

Avoid repetitive freeze-thaw cycles of concentrated primer stocks. 

4.3.2.5   The 1.0, 2.5, 5.0, 12.5 and 25.0 µM working solutions can be stored at either         

-20
o
C or -80ºC freezer 

4.3.2.6   Prepare new working solutions every month or if a significant drop in the 

fluorescence level is observed (for instructions refer to PNQ06_MLVA ABI 

certification, appendix PNQ06-5) 

4.3.3  96-well polypropylene PCR plates (Fisher, Cat. No. 07-200-613) or Microamp PCR 

tubes without caps (Life Technologies, Cat. No. N8010533) 

4.3.4  8-well strip caps for the polypropylene plate (Fisher, Cat. No. 07-200-639) or 

MicroAmp strip caps for the individual tubes (Life Technologies, Cat. No. N8010535) 

4.3.5  DNase-free, molecular biology -grade water 

4.3.6  1.5 ml Eppendorf microcentrifuge tubes 

4.3.7  PCR Nucleotide Mix (ready-to-use dNTP mix containing all four nucleotides; Roche, 

Cat. No. 11 814 362 001) 

4.3.8  Platinum Taq Polymerase with 50 mM MgCl2 and 10X buffer (Life Technologies, Cat. 

No. 10966-034) 

4.3.9    PCR Cooling block (VWR International, Cat. No. 62111-762) 

4.3.10 DNA Engine (Biorad), GeneAmp (Life Technologies) or similar thermocycler with a 

heated lid option and 96-well block format 

4.3.11 Parafilm M, 4” width (VWR, Cat. No. 52858-032) 

4.3.12 Complete set (1000 µl, 200 µl, 100 µl, 20 µl, 10 µl and 2 µl) of single channel 

pipettors for mastermix set-up (“clean set”) 

4.3.13 1-10 µl single channel pipettor for adding DNA templates 

4.3.14 Filtered tips for pipettors  

4.3.15 Microfuge for low (up to 6,000 rpm) rpm spinning 

4.4. Reagents, supplies and equipment needed for Genetic Analyzer 3500  

4.4.1   DNase-free, molecular biology -grade water 

4.4.2   PCR Cooling block (VWR International, Cat. No. 62111-762) 

4.4.3   10 l, 100 l, and 1000 l single channel pipettors 

4.4.4   10 l and 200 µl multichannel pipettors 

4.4.5   Filtered pipette tips 

4.4.6   Sterile solution basins 

4.4.7   1.5 ml Eppendorf microcentrifuge tubes 

4.4.8   96-well polypropylene (non-PCR) V-bottom plate (for dilutions; Fisher Scientific, Cat. 

No. 07-200-698) 

4.4.9 MicroAmp Optical 96-well reaction plates (Life Technologies, Cat. No. 4306737) 

4.4.10 96-well plate base (Life Technologies, Cat. No. 4317237) 
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4.4.11 Rubber septa for 96-well reaction plates (Life Technologies, Cat. No. 4315933) 

4.4.12 96-well plate retainer (Life Technologies, Cat. No. 4317241) 

4.4.13 Hi-Di Formamide (Life Technologies, 25 ml Cat. No. 4311320) 

4.4.14 GeneFlo 625 DNA size standard – ROX, 800 µl (Chimerx, Cat. No. 3125-02) 

4.4.15 GeneScan Fragment Install Standard DS-33 (Life Technologies, Cat. No. 4376911) 

4.4.16 DS-33 Matrix Standard Kit (Dye Set G5) (Life Technologies, Cat. No. 4345833) 

4.4.17 Multi-Capillary DS-30 (Dye Set D) Matrix Standard Kit (Life Technologies, Cat. No. 

4345827) 

4.4.17.1 Needed to establish the system dye color spectra for the instrument. Required 

when analyzing fragments labeled with FAM, HEX, NED, and ROX. 

4.4.17.2 NOTE: DS-33 Matrix Standard (Dye set G5, required for analyzing fragments 

labeled with FAM, VIC, NED, PET, and LIZ) and the GeneScan Fragment 

Installation Standard are typically installed as default as part of the instrument 

installation process. If any of the three standards is missing from the instrument, 

you are not going to be able to start the run. 

4.4.17.3 In order to install the DS-30 Matrix, follow the instructions of the kit insert and 

the “Getting Started Guide”, chapter “Performing a Spectral Calibration” 

4.4.18 3500xL Genetic Analyzer 24-Capillary Array 50 cm (Life Technologies, Cat. No. 

4404689) or the 3500 Genetic Analyzer 8-Capillary Array (Life Technologies, Cat. 

No. 4404685) 

4.4.19 Genetic Analyzer Cathode Buffer Container (4 pack), 1X (Life Technologies, Cat. No. 

4408256) 

4.4.20 Genetic Analyzer Anode Buffer Container (4 pack), 1X (Life Technologies, Cat. No. 

4393927) 

4.4.21 3500 Conditioning Reagent (Life Technologies, Cat. No. 4393718) 

4.4.22 3500 POP7 Performance Optimized Polymer, (384 samples) (Life Technologies, Cat. 

No. 4393708) 

4.4.23 Parafilm M, 4” width (VWR, Cat. No. 52858-032) 

4.4.24 Centrifuge with a microtiter plate rotor 

4.4.25 Heating block or thermal cycler accommodating a 96-well plate for denaturation 

4.4.26 Microfuge for low (up to 6,000 rpm) rpm spinning 

4.5. DNA template preparation  

4.5.1 Day 0: 

4.5.1.1 Streak an isolated colony from test cultures to TSA-SB plate (or comparable 

media). Incubate cultures at 37ºC for 14-18 hrs. 

4.5.2 Day 1: 

4.5.2.1 For each isolate to be typed, aliquot 100 l of sterile, molecular biology-grade 

water into 0.5 ml microfuge tubes. Use a sterile, disposable 1 µl loop to pick 2-3 

colonies (about half of a loopful); rotate the loop in the microfuge tube to release 

the bacteria into the water. Cap and vortex for 10-15 seconds to disperse any 

clumps.  
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4.5.2.2 Place the tubes in a 99-100ºC water bath or heat block for 10-15 minutes. Cool 

briefly on ice or in fridge and centrifuge for 10 minutes at 10,000 rpm. Place on 

ice or in fridge while preparing PCR reactions. These DNA templates can be 

stored at        -20
o
C or -80ºC for several years. 

4.6. PCR procedure 

4.6.1 Day 1: 

4.6.1.1 Fill out, save with the run name, and an organism specific (copy and paste the 

appropriate sizing tables for the controls) MLVA Fragment Analysis ABI 

Worksheet (see appendix PNL28-2) with appropriately labeled samples (a 

maximum of 46 isolates/plate; 44 unknowns + two positive controls and a 

negative control; two wells are reserved for the internal ladder).  

4.6.1.1.1 For each isolate, two wells must be labeled as follows: “BNkeyR1” where 

“BNkey” represents the isolate-specific state laboratory identification 

number (be sure to use the exact same isolate ID that is used in the PFGE 

gels uploaded to the national database) and “R1” represents one of the two 

specific multiplex PCR reactions (R1, R2). 

4.6.1.2 Fill out, and print a PCR mastermix calculation worksheet (see appendices PNL28-

3a, PNL28-3b and PNL28-3c) by typing the number of isolates to be tested (plus 

2-3 extra) in the PCR mastermix calculators labeled R1 and R2. This number is 

highlighted in RED and is next to “number of samples to be analyzed”. The 

mastermixes for reactions 1 and 2 (R1, R2) for one sample are as follows: 

 

STEC O157:H7 (appendix PNL28-3a) 

 

R1   Volume ( µl) Final conc. 

PCR water  5.30 

PCR buffer (10x) 1.00  1x 

MgCl2 (50 mM) 0.40  2.00 mM 

dNTPs (10 mM) 0.20  0.20 mM 

VNTR-3F (25 µM) 0.27  0.67 µM 

VNTR-3R (25 µM) 0.27  0.67 µM 

VNTR-34F (5 µM) 0.24  0.12 µM 

VNTR-34R (5 µM) 0.24  0.12 µM 

VNTR-9F (5 µM) 0.24  0.12 µM 

VNTR-9R (5 µM) 0.24  0.12 µM 

VNTR-25F (2.5 µM) 0.20  0.05 µM 

VNTR-25R (2.5 µM) 0.20  0.05 µM 

Taq (5 U/µl)  0.20  1 U 

   = 9.00 

 

R2   Volume (µl) Final conc. 

PCR water  5.92 
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PCR buffer (10x) 1.00  1x 

MgCl2 (50 mM) 0.40  2.00 mM 

dNTPs (10 mM) 0.20  0.20 mM 

VNTR-17F (5 µM) 0.30  0.15 µM 

VNTR-17R (5 µM) 0.30  0.15 µM 

VNTR-19F (1 µM) 0.16  0.016 µM 

VNTR-19R (1 µM) 0.16  0.016 µM 

VNTR-36F (1 µM) 0.11  0.011 µM 

VNTR-36R (1 µM) 0.11  0.011 µM 

VNTR-37F (2.5 µM) 0.07  0.017µM 

VNTR-37R (2.5 µM) 0.07  0.017µM 

Taq (5 U/µl)  0.20  1 U 

   = 9.00 

 

Salmonella serotype Typhimurium (appendix PNL28-3b) 

 

R1   Volume ( µl) Final conc. 

PCR water  3.81 

PCR buffer (10x) 1.00  1x 

MgCl2 (50 mM) 0.45  2.25 mM 

dNTPs (10 mM) 0.20  0.20 mM 

ST3-F (5 µM)  0.10  0.05 µM 

ST3-R (5 µM)  0.10  0.05 µM 

ST5-F (25 µM) 0.60  1.50 µM 

ST5-R (25 µM) 0.60  1.50 µM 

ST7-F (5 µM)  0.80  0.40 µM 

ST7-R (5 µM)  0.80  0.40 µM 

ST10-F (2.5 µM) 0.12  0.03 µM 

ST10-R (2.5 µM) 0.12  0.03 µM 

Taq (5 U/µl)  0.30  1.50 U 

   = 9.00 

 

R2   Volume (µl) Final conc. 

PCR water  4.38 

PCR buffer (10x) 1.00  1x 

MgCl2 (50 mM) 0.32  1.60 mM 

dNTPs (10 mM) 0.20  0.20 mM 

ST2-F (25 µM) 0.36  0.90 µM 

ST2-R (25 µM) 0.36  0.90 µM 

ST6-F4 (5 µM) 0.56  0.28 µM 

ST6-R2 (5 µM) 0.56  0.28 µM 

ST8-F3 (5 µM) 0.48  0.24 µM 
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ST8-R2 (5 µM) 0.48  0.24 µM 

Taq (5 U/µl)  0.30  1.50 U 

   = 9.00 

 

Salmonella serotype Enteritidis (appendix PNL28-3c) 

 

R1   Volume (µl) Final conc. 

PCR water  4.91 

PCR buffer (10x) 1.00   1x 

MgCl2 (50 mM) 0.40  2.00 mM 

dNTPs (10 mM) 0.20  0.20 mM 

SE1-F (2.5 µM) 0.20  0.05 µM 

SE1-R (2.5 µM) 0.20   0.05 µM 

SE2-F (12.5 µM) 0.32   0.40 µM 

SE2-R (12.5 µM) 0.32  0.40 µM 

SE8-F (2.5 µM) 0.28  0.07 µM 

SE8-R (2.5 µM) 0.28  0.07 µM 

SE6-F (12.5 µM) 0.34  0.43 µM 

SE6-R (12.5 µM) 0.34  0.43 µM 

Taq (5 U/µl)  0.20  1.00 U 

   = 9.00 

 

 

R2   Volume (µl) Final conc. 

PCR water  5.52 

PCR buffer (10x) 1.00  1x 

MgCl2 (50 mM) 0.40  2.00 mM 

dNTPs (10 mM) 0.20  0.20 mM 

SE5-F (2.5 µM) 0.20  0.05 µM 

SE5-R (2.5 µM) 0.20  0.05 µM 

SE3-F (12.5 µM) 0.40  0.50 µM 

SE3-R (12.5 µM) 0.40  0.50 µM 

SE9-F (2.5 µM) 0.08  0.02 µM 

SE9-R (2.5 µM) 0.08  0.02 µM 

Taq (5 U/µl)  0.20  1.00 U 

   = 9.00 

4.6.1.2.1. NOTE: these primer concentrations serve as a starting point. Since 

laboratory-specific factors, such as the age of the primer stocks, calibration 

status of the thermocyclers and pipettes, etc., affect amplification 

efficiency, each laboratory will have to re-optimize the primer 

concentrations for optimal detection of all targets. However, any other 

parameters stated in the SOP should not be changed. 
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4.6.1.3 Thaw all reagents and supplies needed for PCR reactions and place on ice; keep 

primers light protected as much as possible 

4.6.1.3.1 NOTE: PCR mastermixes should be set up in a clean hood that is dedicated 

just for this purpose and where no cultures or DNA are handled.   

4.6.1.4 Prepare the two separate PCR mastermixes in 1.5 ml Eppendorf tubes following 

the instructions in the PCR mastermix calculation worksheet (see appendices 

PNL28-3a, PNL28-3b and PNL28-3c). Keep the mastermix on ice while 

preparing. Add the mastermix components in the following order: water, 10x 

PCR buffer, Mg2Cl, dNTPs, primers, and then finally Taq polymerase. Mix the 

reaction mixture by vortexing briefly. 

4.6.1.4.1 NOTE: All components except Taq polymerase should be vortexed 

thoroughly before adding to the mastermix. Taq may be briefly centrifuged 

with low rpm, if necessary, to pull the enzyme down to the bottom of the 

tube. 

4.6.1.5 Place a 96-well PCR plate or required number of PCR tubes in a PCR cooling 

block. 

4.6.1.6 Dispense 9.0 l of each mastermix into the appropriate rows of the 96-well 

polypropylene plate / PCR tubes as noted in the MLVA Fragment Analysis ABI 

Worksheet (see appendix PNL28-2). 

4.6.1.7 Add 1 l of PCR water to each of the two different wells representing the 

negative controls of the two reactions.     

4.6.1.8 Add 1.0 l of DNA template to each of the two different wells representing the 

two PCR reactions for each isolate to be tested. 

4.6.1.9 Add the positive controls (it is recommended to run the positive control as a 

duplicate).  

4.6.1.9.1 Use STEC O157 strain EDL933 (ATCC 43895) as a positive control. The 

internal ladder to be used will be comprised of pooled PCR products of the 

isolates EC04PN0139 and EC04PN0570 (see appendix PNL28-4 for 

instructions for ladder preparation). 

4.6.1.9.2 Use S. enterica serotype Typhimurium strain LT2 (ATCC 29946) as a 

positive control. The internal ladder to be used will be comprised of pooled 

PCR products of the isolates CDC_2009K0825 and CDC_2009K0826 (see 

appendix PNL28-4 for instructions for ladder preparation). 

4.6.1.9.3 Use S. enterica serotype Enteritidis strain K1891 (ATCC25928) as a positive 

control. The internal ladder to be used will be comprised of pooled PCR 

products of the isolates H9560 and 2010K0017 (see appendix PNL28-4 for 

instructions for ladder preparation). 

4.6.1.10 Cover all wells / tubes with 8-well strip caps and firmly clamp down to avoid any 

evaporation during PCR amplification. 

4.6.1.11 Recommendation: briefly spin down the plate / tubes to remove any air bubbles. 

4.6.1.12 Program and save the following two PCR cycling conditions: 
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STEC O157:H7 and Salmonella serotype Enteritidis 

    

   “O157-SEMLVA” 

   * 95ºC for 5 min  Step 1 

   * 94ºC for 20 sec  Step 2 

   * 65ºC for 20 sec  Step 3 

   * 72ºC for 20 sec  Step 4 

   * Go to step 2, 34x   Step 5 

   * 72ºC for 5 min  Step 6 

   * Indefinite hold at 4ºC  Step 7 

 

   Salmonella serotype Typhimurium 

 

   “STMLVA” 

   * 95ºC for 5 min  Step 1 

   * 94ºC for 20 sec  Step 2 

   * 63ºC for 20 sec  Step 3 

   * 72ºC for 20 sec  Step 4 

   * Go to step 2, 34x   Step 5 

   * 72ºC for 5 min  Step 6 

   * Indefinite hold at 4ºC  Step 7 

 

4.6.1.12.1 NOTE: Make sure to use the heated lid option on the PCR block and 

tube (calculated) temperature control. 

4.6.1.13 When the PCR is complete store the amplification products light-protected at 4ºC 

until ready to run on the sequencer. If the fragment analysis is not performed the 

same day, the plate should be stored at -20
o
C or -80ºC. The PCR products are 

stable for approximately one month, when stored frozen. 

4.7 Initial setup of Genetic Analyzer 3500 instrument before the first run: 
NOTE: step 4.7 only needs to be performed before the very first run. In future runs 

continue directly to step 4.8. 

4.7.1 Click on the “3500” icon to open the 3500 Data Collection Software. The software will 

open a window and the main screen will display the “Dashboard”. If the connections 

are functioning properly, the status light on the sequencer will be green, the “State” of 

the instrument will be “Idle”, and all of the consumables should have the number of 

days/samples remaining for each item.  

4.7.1.1 NOTE: Prior to the first run, but after capillary array installation, the GeneScan 

Fragment Install Standard DS-33, DS-33 and DS-30 matrix standards must be 

installed. In order to run the DS-30 dye matrix standard, the “dye set D” 

parameters must be set up in the Library under the submenu “Dye Set”. To do 

this, click “Create” in the toolbar at the top of the window. In the new window, 

name the new dye set “D” and from the “dye” drop-down menu select “Any 
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Dye”. Uncheck the boxes (not shaded in gray) for the Purple and Orange dyes, 

and click “Save” at the bottom of the window. 

4.7.2 Setting up the Size Standard 

4.7.2.1 Click on the “Library” icon at the top right of the screen. 

4.7.2.2 At the left-hand side of the screen select the “Size Standards” menu option. 

4.7.2.3 At the top of this screen select “Create” in the toolbar. 

4.7.2.4 A new window will appear and in the box next to “Size Standard” enter in 

“GeneFlo625”. 

4.7.2.5 From the “Dye Color” drop-down menu select “Red”. 

4.7.2.6 In the “Enter new Size Standard definition” box enter the fragment sizes for each 

peak (refer to the GeneFlo 625 product insert for the peak sizes). Separate each 

size using a comma. 

4.7.2.7 When finished, click the “Add Size(s)” button, then click “Save” and “Close” 

4.7.3 Setting up Run Parameters: 

4.7.3.1 Once the fragment sizes have been assigned the Assay, File Name Conventions, 

and Results Group will need to be set up. 

4.7.3.1.1 Assay 

4.7.3.1.1.1 At the left-hand side of the screen select the “Assays” menu option and 

click “Create” in the toolbar at the top of the screen. 

4.7.3.1.1.2 For the “Assay Name” enter “Fragtest” and from the “Application Type” 

drop-down menu select “Fragment”. Under the “Protocols” heading 

make sure “No” is selected for assigning multiple instrument protocols. 

4.7.3.1.1.3 Next to “Instrument Protocol” select the “Create New” button. A new 

window will appear. 

4.7.3.1.1.3.1 From the “Dye Set” drop-down menu select “D”. 

4.7.3.1.1.3.2 For the “Run Module” select “FragmentAnalysis50_POP7xl”. 

4.7.3.1.1.3.3 An alert window will pop up asking if you would wish to assign a 

protocol name. Click “Yes” and next to the “Protocol Name” 

replace the ‘_1’ with ‘_2’ (i.e. - FragmentAnalysis50_POP7xl_2). 

Use the default values for all other parameters. This will create a 

new protocol with the specified criterion. 

4.7.3.1.1.3.3.1 NOTE: These are the instrument default running conditions 

for Fragment Analysis with a 50 cm capillary array and 

POP7 polymer. You can check the running conditions by 

clicking the “Library” button at the top right of the 

dashboard and then selecting the “Assays” menu option on 

the left-hand side of the screen. The default conditions are: 

* Oven_Temperature: 60
o
C 

* PreRun_Voltage: 15.0 kVolts 

* Pre-Run-Time: 180 sec. 

* Injection_Voltage: 1.6 kVolts 

* Injection_Time: 15 sec. 
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* Data_Delay_Time: 1 sec. 

* Run_Voltage: 19.5 kVolts 

* Run time: 1330 sec. 

4.7.3.1.1.3.4 When finished, click “Save to Library” and then click “Yes” in the 

pop-up window that asks to apply the changes to the assay. Click 

“OK” to confirm, and then close this window. 

4.7.3.1.1.4 Next to the “Sizecalling Protocol” option select the “Create New” 

button. 

4.7.3.1.1.4.1 In the new window enter “MLVAsizecalling” as the “Protocol 

Name”. 

4.7.3.1.1.4.2 From the “Size Standard” drop-down menu select “GeneFlo625” 

4.7.3.1.1.4.3 Input the following analysis settings:  

* Analysis: Full Range 

* Sizing: Partial Sizing 

 * Start Size: 50 

 * Stop Size 625 

* Size Calling Method: Local Southern Method 

* Primer Peak: Present 

* Minimum Peak Height: 

 * Blue: 600 

 * Green: 600 

 * Yellow: 600 

 * Red: 20 

 * Uncheck Purple and Orange 

* Smoothing: none 

* Baseline window: 51 pts 

* Min. Peak Half Width: 2 pts 

* Peak Window Size: 21 pts 

* Polynomial Degree: 2 

* Slope Threshold Peak Start: 0.0 

* Slope Threshold Peak End: 0.0 

4.7.3.1.1.4.4 Click on “Save to Library” and “Yes” to apply to the assay. Select 

“OK” to confirm and close this window when finished. 

4.7.3.1.1.5 Once all protocols have been established for the new assay, click “Save” 

and close the window to return to the “Library” main screen. 

4.7.3.1.2 File Name Conventions 

4.7.3.1.2.1 Access the “File Name Conventions” menu on the left-hand side of the 

screen. In the toolbar at the top of the screen select “Create”. 

4.7.3.1.2.2 In the window that appears enter “MLVA” next to the “Name” option. 

4.7.3.1.2.3 Use the default settings and click “Save” and close the window.  

4.7.3.1.3 Results Groups 
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4.7.3.1.3.1 Access the “Results Groups” menu on the left-hand side of the screen. In 

the toolbar at the top of the screen select “Create”. 

4.7.3.1.3.2 In the window that appears, enter “MLVA1” as the name for this results 

group. 

4.7.3.1.3.2.1 When the results group reaches its upper size limit set up a new 

results group with a different name (MLVA2, MLVA3…). 

4.7.3.1.3.3 Under the “Delimiters” section heading click the “Add” button to insert a 

dash in the “Selected Attributes” box on the right-hand side of the 

window. 

4.7.3.1.3.4 From the “Available Attributes” list, scroll down to the “Plate Name” 

option. Select it and click the “Add” button in between the two boxes to 

add it to the “Selected Attributes” list. 

4.7.3.1.3.5 Uncheck the “Include an Instrument Run Name folder” and “Include an 

Injection folder” options, keeping all other default parameters. 

4.7.3.1.3.6 Save the results group to the library and close this window. 

4.8  Genetic Analyzer 3500 instrument preparation before each run 

4.8.1. Day 1 

4.8.1.1 Make sure the service console is open and the status light on the sequencer is 

green. Make sure a capillary array is installed in the instrument. For installation, 

follow the instructions of the “Install Capillary Array” wizard. You can find the 

wizards by clicking on the “Maintenance” option in the toolbar at the top right of 

the screen and then clicking on the “Maintenance Wizards” menu option in the 

left-hand panel. Spectral and spatial calibrations will need to be run for each array 

installation. Before setting up a run, check to make sure that the consumables are 

not expired. 

4.8.1.1.1 NOTE: The RFID tags on the packaging of the consumables automatically 

log in the hours spent on the instrument. The run will not start with expired 

reagents. 

4.8.1.2 Go back to the Dashboard screen by clicking the “Dashboard” button at the top 

left of the screen 

4.8.1.3 Select the “Create New Plate” icon at the top of the screen. Name the run 

following the standardized PulseNet naming system: use the unique identifier 

code that was assigned to your laboratory by PulseNet for the first two to four 

letters of the file name. The next two spaces will indicate the year and the next 

four spaces will indicate the month and the date the run was performed. For 

example GA070426 is a run made at the GA Public Health Laboratory on April 

26, 2007. If several runs are performed the same day, separate the file names by 

using sequential numbers, for example GA070426-1, GA070426-2. 

4.8.1.4 From the “Plate Type” drop-down menu, select “Fragment”. 

4.8.1.5 Type in the Owner name or initials. 

4.8.1.6 Use the default settings (50cm array, POP-7 polymer) for the remaining options 

and click on the “Assign Plate Contents” button at the bottom of the screen. 
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4.8.1.7 The plate view screen will appear 

4.8.1.8 Here you can type in the sample IDs or import a sample plate file from a template 

(see Appendix PNL28-5 for instructions on importing plate .txt files). 

4.8.1.9 To assign the Assay to the plate, proceed as follows:  

4.8.1.9.1 Click on “Add from Library” in the “Assays” box at the bottom of the screen.  

4.8.1.9.2 In the new window select “Fragtest” from the list of assays. 

4.8.1.9.3 Add this assay by clicking on the “Add to Plate” button, and then close the 

window. 

4.8.1.10 Adding the File Name Conventions (MLVA) and Results Groups (MLVA1) can 

be done in the same manner, by selecting the “Add from Library” link in the 

respective boxes. 

4.8.1.11 Once the assay, file name convention and results group have been added to the 

plate, select the entire sample ID set by highlighting the individual cells or by 

clicking on column/row headings. 

4.8.1.12 Check the box next to each of the run parameters: Assay, File Name Convention, 

and Results Group. 

4.8.1.13 When each of the run parameters have been successfully assigned a dot will 

appear in the center of the cells in which the parameters were applied. 

4.8.1.13.1 NOTE1: If a plate layout has been imported from a .txt file the Assay, File 

Name Convention and Results Group should automatically be applied to 

the plate and check-marked for all samples. 

4.8.1.13.2 NOTE2: What identifiers are shown in the sample ID cells can be changed 

by selecting or deselecting options in the “Show In Wells” drop-down 

menu above the sample plate layout. Assays, file name conventions, and 

results groups can be color coded by double-clicking the black dot to the 

left of the file name or during initial setup. 

4.8.1.14 Save the plate by clicking the “Save Plate” button in the toolbar at the top of the 

screen and selecting “Save” from the drop-down menu.  

4.8.1.15 Go back to the dashboard screen by clicking the “Dashboard” button in the top 

left corner of the screen and continue with fragment analysis preparation. 

4.8.1.16 If needed, install the POP7 polymer in the instrument. 

4.8.1.16.1 Click on the “Maintenance” button in the toolbar at the top right of the 

window, and then select the “Maintenance Wizards” menu option on the 

left-hand side. 

4.8.1.16.2 Follow the instructions of the “Replenish Polymer” wizard. 

4.8.1.17 If needed, also install new anode and cathode buffer containers. 

4.8.1.17.1 NOTE1:  If an old polymer pouch (been on the instrument > 7 days) is 

switched to a new one, follow the instructions of the “Wash Pump and 

Channels” wizard instead. This process takes 30 minutes to complete and 

requires a conditioning pouch.  
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4.8.1.17.2 NOTE2: To update the system after new reagents have been installed, click 

the “Refresh” button under the “Consumables Information” heading on the 

Dashboard. 

4.9. Fragment analysis sample preparation 

4.9.1 Day 1  

4.9.1.1 NOTE: The fragment analysis method is not organism specific therefore; STEC 

O157 and Salmonella serotypes Typhiumurium and Entertidis may be run on a 

single fragment analysis plate. 

4.9.1.2 Thaw the Hi-Di Formamide, the GeneFlo 625 DNA size standard and the internal 

ladder (see appendix PNL28-4) and place on ice. 

4.9.1.2.1   NOTE: aliquot Hi-Di Formamide (500 µl / tube) and the size standard (50 

µl / tube) in order to avoid frequent freeze-thaw cycles. 

4.9.1.3 Prepare a 96-well V-bottom plate for diluting the PCR reactions. Using a 200 µl 

multichannel pipettor and a solution basin, dispense 19 µl of molecular-grade 

water in the required number of wells.  

4.9.1.4 Remove the plate / tubes with the PCR reactions from the thermocycler. Briefly 

spin down the plate / tubes, if necessary. Use a 10 µl multichannel pipettor to 

transfer 1 µl of each PCR reaction directly across to the corresponding set of 

wells in the dilution plate. In order to avoid cross-contamination, remove the strip 

cap from just one column at a time and recap the column before opening the next 

one.  

4.9.1.5 For the internal ladder, combine R1 and R2 PCR products from the four PCR 

reactions of both internal ladder isolates to end up with a total of 40 µl. Mix well 

by pipetting up and down a few times and add 3 l of internal ladder in two 

wells. 

4.9.1.6 Using a 200 µl multichannel pipettor, mix the dilutions by pipetting up and down 

a few times. Cover the plate with parafilm and put in the fridge or on ice. 

4.9.1.7 Prepare a fragment analysis master mix containing DNA size standard and Hi-Di 

Formamide for the samples following the calculations indicated in the table 

below. The fragment analysis mastermix calculations can also be performed 

using the autocalculate box at the bottom of the MLVA Fragment Analysis ABI 

Worksheet (see appendix PNL28-2). Vortex briefly and place on ice. 

 

Reagents Frag. anal. mastermix 

Hi-Di Formamide 8 µl x (# samples +3)= 

GeneFlo 625 bp size standard     1 µl x (# samples +3)= 

 

4.9.1.8 Place a MicroAmp Optical 96-well sample plate in a cold block. Aliquot 9 µl of 

the prepared fragment analysis mastermix to the required number of wells. Cover 

the plate loosely with Parafilm. 
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4.9.1.9 Using the 10 µl multichannel pipettor, add 1 µl of 1:20 diluted PCR reactions to 

the appropriate columns in the sample plate. Keep sliding the Parafilm sheet from 

column to column to keep track of the sample order.   

4.9.1.10 Denaturate templates by heating the reaction plate uncovered in a thermocycler at 

95
o
C for 3 min. 

4.9.1.11 While the templates denaturate, turn the oven of the 3500 on using the “Start Pre-

Heat” button located on the middle, right-hand side of the dashboard. The default 

set point should be 60°C. 

4.9.1.12 Briefly spin down the sample plate to remove any air bubbles. 

4.9.1.13 Seal the plate with the rubber septa. Place the sample plate in a plate base. Snap 

the plate retainer onto the plate and the plate base.    

4.9.1.14 Place the plate assembly and the buffer into the Genetic Analyzer 3500. 

4.9.1.14.1 Push the tray button at the front of the Genetic Analyzer 3500 to bring the 

autosampler to the forward position. Open the instrument door. 

4.9.1.14.2 Place the plate assembly on the autosampler in position A or B with the 

notched corner of the plate base facing you. 

4.9.1.14.3 Close the instrument door and wait for the green light to illuminate. 

4.9.1.14.4 Open the previously created plate setup by clicking the blue “Edit Existing 

Plate” button at the top of the dashboard screen. 

4.9.1.14.5 Select the plate to be run and click “Open”. 

4.9.1.14.6 Link the plate by clicking “Link Plate for Run” at the bottom of the screen 

4.9.1.14.7 A “Load Plate” pop-up window will verify that the plate has been 

successfully loaded. Click “OK”. 

4.9.1.15 The “Start Run” button at the bottom of the screen will become functional 

indicating that the run can be started. Make sure the plate is linked to the correct 

position (A or B), then click the “Start Run” button. Click “OK” on the alert 

window. The run will start. 

4.10. Viewing and exporting data from the Genetic Analyzer 3500  

4.10.1 Day 2 

4.10.1.1 NOTE: Steps 4.10.1.3 and 4.10.1.4 only need to be performed before the very 

first analysis.  

4.10.1.2  Double-click on the shortcut icon for GeneMapper v4.1 or higher and enter the 

appropriate password to access the software. The main menu window will open. 

4.10.1.3 Set up the size standard: 

4.10.1.3.1 From the “Tools” drop-down menu, select “GeneMapper Manager”. A 

“GeneMapper Manager” window will open. 

4.10.1.3.2 Select the “Size Standards” tab. 

4.10.1.3.3 Click on “New”, leave the default option “Basic or Advanced” selected and 

click “OK”. The “Size Standard Editor” window will appear. 

4.10.1.3.4 Name the new size standard “GeneFlo625”. 

4.10.1.3.5 Leave the default option “Red” as “Size Standard Dye”. 
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4.10.1.3.6 Enter sizes for each peak in the table (refer to the GeneFlo 625 product 

insert for the peak sizes). 

4.10.1.3.7 When finished, click “OK”. 

4.10.1.4 Set up analysis method: 

4.10.1.4.1 From the “Tools” drop-down menu, select “GeneMapper Manager”. A 

“GeneMapper Manager” window will open. 

4.10.1.4.2 Select the “Analysis Methods” tab. 

4.10.1.4.3 Click on “New”, leave the default option “Microsatellite” selected and click 

“OK”. The “Analysis Methods Editor” window will appear. 

4.10.1.4.4 Name the new method “PNMLVA”.and click “OK”. 

4.10.1.4.5 Highlight the new method name “PNMLVA” and click “Open”. 

4.10.1.4.6 Select the “Peak Detector” tab and change “Peak Detection Algorithm” to 

“Advanced” from the drop-down menu. 

4.10.1.4.7 Input the following analysis settings and click “OK” when finished: 

  *Analysis: Full Range 

  * Sizing: Partial Sizing 

  *Start Size: 50 

  * Stop Size 625 

  * Smoothing: none 

  * Baseline window: 51 pts 

  * Size Calling Method: Local Southern Method 

  * Peak Amplitude Thresholds: 

   * B: 600 

   * G: 600 

   * Y: 600 

   * R: 20 

   * P: 50 

   * O: 50 

  * Min. Peak Half Width: 2 pts 

  * Polynomial Degree: 2 

  * Peak Window Size: 21 pts 

  * Slope Threshold: 

   * Peak Start: 0.0 

   * Peak End: 0.0 

  * Leave the “Enable Normalization” option unchecked 

4.10.1.4.8 Click “Done” to close the GeneMapper Manager window and return to the  

 main screen. 

4.10.1.5 From the “File” drop-down menu select “Add Samples to Project”. 

4.10.1.6 Find the folder containing the data file to be analyzed: My Computer → AB SW 

& DATA (D:) → Applied Biosystems → 3500 → Data → MLVA1-

<PlateName>. 
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4.10.1.7 Highlight the desired file(s) and click on “Add to List”. File(s) will appear in the 

window on the right. Click “Add” below the file list to return to the original 

screen. 

4.10.1.8 Samples in the selected file(s) will be listed in a new window and the “Analyze” 

(play) button appears in green color in the toolbar indicating that the files are 

ready to be analyzed. 

4.10.1.9 Select the size standard GeneFlo625 for the first sample, highlight the size 

standard column by selecting the heading, and select “Fill Down” from the “Edit” 

drop-down menu. 

4.10.1.10 Select the analysis method PNMLVA for the first sample, highlight the analysis 

method column, and select “Fill Down” from the “Edit” drop-down menu. 

4.10.1.11 Click on the “Play” icon. 

4.10.1.12 Name the project with the run name (for example, “GA070426”) and click “OK”. 

4.10.1.13 A successful analysis is indicated by green squares. Yellow triangles indicate 

problematic components (i.e. missing size standard peaks). Red circles indicate 

results fell below acceptable quality values. Samples with yellow or red circles in 

the SQ column should be selected for re-analysis. 

4.10.1.13.1 To resolve failed analyses due to sub-optimal molecular marker peak 

profile (i.e. miscalling of peaks), select a row(s) with a yellow triangle or a 

red circle in the SQ column and click on the “Size Match Editor” icon on 

the toolbar. The “Size Match Editor” view will appear. 

4.10.1.13.2 Place the cursor near the X-axis to activate the magnifying lens, and 

then pull up (mouse left-click and hold) to zoom in a specific area to 

facilitate editing 

4.10.1.13.3 Left-click at the base of a peak to select. Right-click and select 

“Add”, “Delete”, or “Change”. 

4.10.1.13.4 Select the correct molecular weight for the selected peak from the 

drop-down menu. Repeat this process for all other miscalled peaks. Click 

“OK” when finished. 

4.10.1.13.5 After the size standard has been adjusted, click the “Play” button to 

re-analyze the data. After a successful analysis, the samples will have green 

squares under the SQ column. If the size standard cannot be adjusted, the 

reaction is considered a fragment analysis failure and must be re-run 

4.10.1.14 Check the fragment result data (the fluorescent peaks) for each well by 

highlighting the well ID and by clicking on the “Display Plots” icon on the 

toolbar.  

4.10.1.14.1 Make sure that all VNTRs amplified in the positive control and that 

the fragment sizes are within the range specified in the appendix PNL28-2 

and record the fragment sizes on the MLVA Fragment Analysis ABI 

Worksheet. 

4.10.1.14.2 The size calling for the internal ladder should also be within the range 

specified in the appendix PNL28-2 (or PNL28-4).  



LABORATORY STANDARD OPERATING PROCEDURE FOR PULSENET 

MLVA OF SHIGA TOXIN-PRODUCING ESCHERICHIA COLI O157 (STEC 

O157) AND SALMONELLA ENTERICA SEROTYPES TYPHIMURIUM AND 

ENTERITIDIS– APPLIED BIOSYSTEMS GENETIC ANALYZER 3500 

PLATFORM 

CODE: PNL28 

Effective Date: 

02 26 14 
 

 

  VERSION: REPLACED BY: AUTHORIZED BY:  

 

17 of 28 

 

4.10.1.14.3 Write down any failed reactions in the MLVA Fragment Analysis 

ABI Worksheet. Make a note of non-specific bands and primer-dimers. 

4.10.1.15 Export the peak file: 

4.10.1.15.1 NOTE1: the following column headings should appear in the 

exported table in the following order from left to right: “Dye/Sample 

Peak”, “Sample File Name”, “Marker”, “Allele”, “Size”, “Height”, “Area 

in Point”, “Data Point”. You can modify the format of the table by selecting 

the “Table Setting Editor” from the “Tools” drop-down menu. Select the 

“Genotypes” tab and make sure that only the boxes for the following are 

checked: “Sample File Name”, “Marker”, “Dye”, “Allele”, “Size”, 

“Height”, “Area in Point”, and “Data Point”. 

4.10.1.15.2 NOTE 2: You can import the peak file also from the Data Collection 

Foundation software, but the file format is not correct; the “Allele” and 

“Marker” columns are missing and there are additional columns in the file. 

This file cannot be imported into BioNumerics without first manually 

modifying (adding and deleting appropriate columns) the file.  

4.10.1.15.3  Highlight the samples for which you want to export peak data. 

4.10.1.15.4  Click on the “Display Plots” icon on the toolbar. 

4.10.1.15.5  Click on the “Sizing Table” icon on the toolbar and a table will 

appear below the electropherograms. 

4.10.1.15.6 From the “File” drop-down menu, select “Export Table”. 

4.10.1.15.7 Select the location (for example a flash drive) where you want to 

export the data. 

4.10.1.15.8 Name the export file with the run name (for example GA070426) and 

make sure the file type is tab-delimited text (.txt) file. 

4.10.1.16 The remaining gel can stay in the instrument if it is going to be used within 7 

days. 

4.10.1.16.1 NOTE: To extend life of polymer, remove after run, place in 

refrigerator, and replace with an old polymer (on instrument longer than 7 

days) until next use. Polymer should not be on instrument for more than a 

total of 7 days.   
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8. AMENDMENTS: 

5/6/2013: former appendix PNL28-4 (BioNumerics specifications for the E. coli O157 VNTR loci) 

was moved to SOP PND16 (PulseNet standard operating procedure for analysis of MLVA data of 

Shiga toxin-producing Escherichia coli in BioNumerics – Applied Biosystems Genetic Analyzer 

3130/3500 data). Former appendices PNL28-5 and PNL28-6 were renamed PNL28-4 and PNL28-5, 

respectively. 

2/26/2014: the three laboratory SOPs for STECO157 (PNL28), and Salmonella serotypes 

Typhimurium (PNL29) and Enteritidis (PNL30) using the ABI 3500 platform were combined into a 

single SOP (PNL28). 
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Appendix PNL28-1 

 

MLVA PCR Primer sequences for STEC O157:H7 and Salmonella serotypes Typhimurium and Enteritidis 
      

Locus  Dye
1
  Forward Primer (5’ to 3’)      Reverse Primer (5’ to 3’) 

________________________________________________________________________________________________________________________________________________ 

STEC O157:H7     
VNTR-3  CalRed590 GG CGG TAA GGA CAA CGG GGT GTT TGA ATT G  GAA CAA CCT AAA ACC CGC CTC GCC ATC G 

VNTR-34 FAM  GA CAA GGT TCT GGC GTG TTA CCA ACG G    GTT ACA ACT CAC CTG CGA ATT TTT TAA GTC CC 

VNTR-9  FAM  GC GCT GGT TTA GCC ATC GCC TTC TTC C   GTG TCA GGT GAG CTA CAG CCC GCT TAC GCT C 

VNTR-25 HEX  GC CGG AGG AGG GTG ATG AGC GGT TAT ATT TAG TG GCG CTG AAA AGA CAT TCT CTG TTT GGT TTA CAC GAC 

VNTR-17 CalRed590 GC AGT TGC TCG GTT TTA ACA TTG CAG TGA TGA    GGA AAT GGT TTA CAT GAG TTT GAC GAT GGC GAT C 

VNTR-19 FAM  GC AGT GAT CAT TAT TAG CAC CGC TTT CTG GAT GTT C  GGG GCA GGG AAT AAG GCC ACC TGT TAA GC 

VNTR-36 FAM  GG CGT CCT TCA TCG GCC TGT CCG TTA AAC  GCC GCT GAA AGC CCA CAC CAT GC 

VNTR-37 HEX  GC CGC CCC TTA CAT TAC GCG GAC ATT C   GCA GGA GAA CAA CAA AAC AGA CAG TAA TCA GAG CAG 

C  

 

Salmonella Typhimurium 

ST3       HEX                      GT TCT TCT GCA ACG CAG GCA    GAT GGC ATG ACG CTG CAA CG 

ST5       FAM                     TT TTC GCT CAA CAA ACT T       ACA GCA CCA GAA GCA AT 

ST7       CalRed590            CG ATT GAC GAT ATC TAT GAC TT    GTT TTT CAC GTT TGC CTT TC 

ST10       HEX                     CG GGC GCG GCT GGA GTA TTT G    GAA GGG GCC GGG CAG AGA CAG C 

ST2       FAM                     CA ACG CCT GTT CAG CAA C       ATC AAC AGC GGG TGG AT 

ST6       CalRed590           AG CAG TGG CTG GCG GGA AAC C     GCA GCC GGA CAG GGG ATA AGC C 

ST8              HEX                     GC AGG TGT GGC TAT TGG CGT TGA AA   GAT GGT GAC GCC GTT GCT GAA GG 

 

Salmonella Enteritidis 

SE-1  FAM  TGT GGG ACT GCT TCA ACC TTT GGG C   CCA GCC ATC CAT ACC AAG ACC AAC ACT CTA TGA 

SE-2  CallRed590 GTG CTT CCT CAG GTT GCT TTT AGC CTT GTT CG  GGG GAA TGG ACG GAG GCG ATA GAC G 

SE-8  HEX  GGT AGC TTG CCG CAT AGC AGC AGA AGT   GGC GGC AAG CGA GCG AAT CC 

SE-6  FAM  CTG GTC GCA GGT GTG GC     GGT GAC GCC GTT GCT GAA GGT AAT AAC AGA GTC  

SE-5  HEX  GGC TGG CGG GAA ACC ACC ATC     GCC GAA CAG CAG GAT CTG TCC ATT AGT CAC TG 

SE-3  CallRed590 CGG GAT AAG TGC CAC ATA ACA CAG TCG CTA AGC CGC CAG TGT TAA AGG AAT GAA TGA ACC TGC TGA TG 

SE-9  FAM  CCA CCT CTT TAC GGA TAC TGT CCA CCA GC  GGC GTT ACT GGC GGC GTT CG 

________________________________________________________________________________________________________________________________________________ 
1 
Only the 5’ of the forward primer is fluorescently labeled 
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Appendix PNL28-4 
 

Instructions to prepare the internal ladders 

 

1. Prepare DNA templates from isolates as described in the protocol step 4.5. Store the templates at -20
o
C or -

80
o
C freezer. 

1.1 For STEC O157:H7, use the strains EC04PN0139 and EC04PN0570 

1.2 For Salmonella serotype Typhimurium, use strains 2009K0825 and 2009K0826 

1.3 For Salmonella serotype Enteritidis, use strains H9560 and 2010K0017 

2. Use the DNA templates to set up and run the PCR reactions R1 and R2 as described in the protocol step 4.6. 

3. After PCR amplification, pool the R1 and R2 reactions for the two strains into one single PCR tube to end 

up with a final volume of 40 µl. Mix by pipetting up and down a few times. 

4. A new lot of internal ladder must be tested against the old ladder lot by running them in the same fragment 

analysis run. 

5. Store the ladder in -20
o
C or -80

o
C freezer. It should remain stable at least 5-6 freeze-thaw cycles for a 

period of one month. 

 

Expected fragment sizes (bp) of the fifteen fragments (locus VNTR_36 is a null allele in EC04PN0139) 

present in the STEC O157:H7 internal ladder as listed in the peak file: 

VNTR-36 (B):  170 - 172  NA 

VNTR-34 (B):  222 - 224  260 - 262 

VNTR-19 (B):   296 - 298  320 - 322 

VNTR-9 (B):   518 - 522  565 - 569 

VNTR-25 (G):  127 - 128  138 - 140 

VNTR-37 (G):  192 - 194  198 - 200 

VNTR-17 (Y):  153 - 155  177 - 179 

VNTR-3 (Y):   397 - 401  433 - 435 

 

Expected fragment sizes (bp) of the fifteen fragments (locus VNTR_36 is a null allele in EC04PN0139) 

present in the STEC O157:H7 internal ladder as they appear in the electropherogram: 

VNTR-25 (G):  127 - 128  138 - 140 

VNTR-17 (Y):  153 - 155  177 - 179 

VNTR-36 (B):  170 - 172  NA 

VNTR-37 (G):  192 - 194  198 - 200 

VNTR-34 (B):  222 - 224  260 - 262 

VNTR-19 (B):   296 - 298  320 - 322 

VNTR-3 (Y):   397 - 401  433 - 435 

VNTR-9 (B):   518 - 522  565 - 569 
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Expected fragment sizes (bp) of the fourteen fragments present in the Salmonella serotype Typhimurium 

internal ladder as listed in the peak file: 

ST5 (B):   184 - 185  231 - 233 

ST2 (B):   370 - 373  399 - 401 

ST3 (G):   177 - 180  188 - 192 

ST10 (G):   383 - 384  413 - 415 

ST8 (G):   582 - 584  589 - 591 

ST7 (Y):   137 - 139  147 - 151 

ST6 (Y):   253 - 255  283 - 285 

 

Expected fragment sizes (bp) of the fourteen fragment present in the Salmonella serotype Typhimurium 

internal ladder as they appear in the electropherogram: 

ST7 (Y):   137 - 139  147 - 151 

 ST3 (G):   177 - 180  188 - 192 

ST5 (B):   184 - 185  231 - 233 

ST6 (Y):   253 - 255  283 - 285 

 ST2 (B):   370 - 373  399 - 401 

ST10 (G):   383 - 384  413 - 415 

ST8 (G):   582 - 584  589 - 591 

 

Expected fragment sizes (bp) of the thirteen fragments (SE9 has the same allele in both ladder strains) 

present in the Salmonella serotype Enteritidis internal ladder as listed in the peak file: 

SE9 (B) 181 - 184  181 - 184   

SE6 (B): 446 - 447 479 - 482  

SE1 (B) 190 - 193 211 - 213 

SE5 (G):  201 - 203 218 - 221 

SE8 (G): 346 - 350 433 - 436 

SE3 (Y):  199 – 203 211 - 215 

SE2 (Y):  317.5 - 324 363 - 364 

 

Expected fragment sizes (bp) of the fifteen fragments (SE9 has the same allele in both ladder strains) 

present in the Salmonella serotype Enteritidis internal ladder as they appear in the electropherogram: 

SE9 (B) 181 - 184 181 - 184 

SE1 (B) 190 - 193 211 - 213 

SE3 (Y):  199 - 203 211 - 215 

SE5 (G):  201 - 203 218 - 221 

SE2 (Y):  317.5 - 324 363 - 364 

SE8 (G): 346 - 350 433 - 436 

SE6 (B): 446 - 447 479 - 482 

 

NOTE: fragment size ranges for the internal ladders are based on multiple independent runs at CDC and 

PulseNet Participating Laboratories 
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Appendix PNL28-5 
 

Steps for Exporting and Importing Plate Set ups on the ABI 3500 

 

Note:  the procedure described below will require the sequencer computer to have Microsoft Office. If the 

sequencer computer does not have Microsoft Office, the exported file needs to be saved on a flash drive so that 

steps 10 through 16 can be performed on a computer with Microsoft Office. 

 

1. On the Dashboard screen click on the “Edit Existing Plate” button. 

2. Select “Fragment” from the “Filter” drop-down menu. 

3. Find the most recent full plate. Click on the ID to highlight the desired plate and then click the “Open” 

button at the bottom of the window. 

3.1. NOTE: If you do not have a full plate, create a new one by filling in each sample ID space (A01 

through H12) with “test” and saving it with the plate name “MLVA_Template”. Be sure to add the 

results group “MLVA1”, file name convention “MLVA”, and Assay “Fragtest” to each sample, making 

sure each one is check-marked. It is necessary to have all required wells filled in when exporting so that 

they will be available in your exported file. 

4. In the plate layout window, click the “Export…” button in the toolbar at the top of the screen. 

5. In the export window, create a new folder on the desktop by clicking the “Desktop” icon on the left side of 

the window. Find the ‘New Folder’ button in the toolbar at the top of the window and name the new folder 

“MLVA Plate Setup”. 

6. Save the file to this folder by using your new plate name (e.g. - CDC110726) and clicking “Save”. 

7. A window will pop up letting you know that the plate has been successfully exported. Click “OK”. 

8. Click the “Close Plate” button in the toolbar at the top of the plate layout screen, and click “Yes” to close 

without saving changes.  

9. Minimize the 3500 program window and open the “MLVA Plate Setup” folder on the desktop. 

10. Right-click your plate name, select “Open With” and in the submenu select Microsoft Office Excel. 

11. Sample IDs can be typed or copy and pasted from a separate Excel file into the spaces next to the correct 

wells under the “Sample Name” heading. 

11.1. NOTE: Do not change/delete any of the column headings. The fields must be in the same format 

when importing as they were when exported. Additionally, the software will not import the file if the 

sample IDs contain special characters (e.g. - ! , / , ) , etc). You can use underscores and dashes. 

12. The “Plate Name” should be changed to match the plate/file name, and initials should be placed under the 

‘Owner Name’ heading. The defaults for “Application Type”, “Capillary Length (cm)”, “Polymer”, and 

“Number of Wells” should be used. 

13. Once all of the IDs are inserted, make sure that for each sample ID and all controls, the assay is “Fragtest”, 

the results group name is “MLVA1”, the file name convention is “MLVA”, and “Sample” is listed under 

“Sample Type”. 

14.  Under the “File” drop-down menu select “Save”. 

15. A warning window will appear asking if the workbook should be saved in the “Text (tab-delimited)” format. 

Click “Yes”. 

16. Exit Microsoft Excel, clicking “No” when prompted to save changes. 

16.1. NOTE: The removal of additional spaces from lines in the .txt file after modification in Excel may be 

necessary before importing into the “3500” program. To do this, open the file in “Notepad” making 
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sure the window is opened in full screen. In lines 1, 2, and 4 remove any additional spaces after the last 

character in the line or from the left side of the page. Once all spaces have been removed from those 

lines, save the file by clicking “Save” in the “File” drop-down menu and close the window. 

17. Go to the ABI 3500 plate layout window by clicking “Create New Plate” on the Dashboard.  

18. Enter in the name of the plate and from the “Plate Type” drop-down menu select “Fragment”. 

19. Click on the “Assign Plate Contents” button at the bottom of the screen. 

20. In the toolbar at the top of the “Plate View” screen, click the “Import...” button.  

21. In the import window, navigate to the recently created plate under Desktop/MLVA Plate Setup. Select the 

appropriate .txt file and click “Open”.  

21.1. At this point an error message may appear asking if you would like to proceed. If you encounter this 

message, click the “Proceed” button at the bottom of the window. 

22. When the file has been imported, an alert window will appear stating that the plate “has been successfully 

imported”. Click “OK”. 

23. In the toolbar at the top of the screen click on “Save Plate” and from the drop-down menu select “Save As”. 

Enter the plate name matching the name of the .txt file, and click “OK”. 

23.1. NOTE: When importing a plate layout from a .txt file the Assay, File Name Convention and Results 

Group should automatically be applied to the plate and check-marked for all samples. If the .txt file 

does not contain the correct assay file name (e.g. – the name is misspelled, etc.), the assay will not be 

imported and the file name convention and results group will be imported but not check-marked. 

23.2. NOTE2: For repeated use, plate templates can be created by exporting a plate to the “MLVA Plate 

Setup” folder. Save the file as a tab-delimited text file with “test” as the sample ID and with a new plate 

name (e.g. - “MLVA_Template”). After you have filled out the information for a new run on the 

template, save it in step 14 with the standardized run name (name (e.g. - CDC101020).  


